
                    
                
        
            
                                        
        
        
    

    
        

    


    
        
            
                                    
                        
                    
                            

                        
                
                    	Home
	
                                                                            For Business
                                                                        
                                        
                                                                                            Enterprise

                                                                                        Organizations

                                            Medical

                                            Insurance

                                            Real Estate

                                            Tax & Finance

                                            Legal

                                            Human Resources

                                            See All

                                        

                                    

                                
	
                                                                            Developers
                                                                        
                                        
                                            PDF Tools API

                                            pdfFiller API

                                            API Documentation

                                            API Pricing

                                            Integrations
                                                
                                                    
                                                        Salesforce

                                                        Dynamics

                                                        See All

                                                    

                                                

                                            

                                        

                                    

                                
	Features
	Support
	
                                                                                                                                    Start Free Trial
                                                
                                                                                                                        
	
                                            Pricing
                                        
	Log in


                
            

                        
                
                    
                
            

        

    



                            

            
                                    
    
        
            

        

        
            
                                                            Home

                                                                                
                            For Business

                            
                                Enterprise

                                Organizations

                                Medical

                                Insurance

                                Real Estate

                                Tax & Finance

                                See All

                            

                        

                                                                                
                            Developers

                            
                                PDF Tools API

                                pdfFiller API

                                API Documentation

                                API Pricing

                                Integrations

                            

                        

                                                                                Features

                                                                                Support

                                                                                Pricing

                                                                                Log in

                                                

        

        
                            Log in

                Don’t have an account? Get Started

                    

    




                            
            

            
                
            
    
        
                	
                    
                        Home
                    
                
	
                    
                        Functionality index
                    
                
	
                    
                        PDF Converter: Convert PDF to Editable
                    
                
	
                    
                        Turn PDF
                    
                
	
                    Turn PDF into Powerpoint
                


    
        

        
                        Turn PDF into powerpoint For Free
                    

                    
        
            

        

                    

    



    


                    

        Today AUG 18TH, 2022*

        
            
                
                    
                        

                        
                            0

                            Forms filled

                        

                    

                

                
                    
                        

                        
                            0

                            Forms signed

                        

                    

                

                
                    
                        

                        
                            0

                            Forms sent

                        

                    

                

            

        

    




        
    
        
            
                
                    
                        
                        
                        
                    
                    
                                                    Upload your document to the PDF editor
                                            

                

            

            
                
                    
                        
                        
                        
                    
                    
                                                    Type anywhere or sign your form
                                            

                

            

            
                
                    
                        
                        
                        
                    
                    
                                                    Print, email, fax,  or export
                                            

                

            

            
                
                    
                        
                        
                        
                    
                    
                                                    Try it right now! Edit pdf
                                            

                

            

        

    


            
    
        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates

                    

                                    
                        4M

                        PDFs edited per month

                    

                                    
                        238K

                        documents shared 
per month

                    

                                    

    


            
        
            
                
                                            
                            Turn PDF into PowerPoint
                        

                                        
                        
                            
                            
                            
                            
                            
                            
                        
                    


                                                                        Convert your PDF files into PowerPoint presentations effortlessly with our powerful feature.

                                                                                                Key Features:

                                                                                                
                                                                    
                                        Seamless PDF to PowerPoint conversion

                                    

                                                                    
                                        Preserve formatting and layout

                                    

                                                                    
                                        Intelligent image extraction

                                    

                                                                    
                                        Editable text in PowerPoint slides

                                    

                                                                    
                                        Batch conversion of multiple PDf files

                                    

                                                            

                                                                                                Potential Use Cases and Benefits:

                                                                                                
                                                                    
                                        Efficiently repurpose content: Transform PDF reports, ebooks, and documents into dynamic and engaging presentations.

                                    

                                                                    
                                        Streamline business processes: Convert PDFs of business plans, proposals, and sales presentations to PowerPoint for easy editing and collaboration.

                                    

                                                                    
                                        Enhance teaching and learning: Quickly convert PDF lecture slides, educational materials, and research papers into interactive PowerPoint presentations.

                                    

                                                                    
                                        Save time and effort: Eliminate the need for manual copy-pasting or recreating PowerPoint slides from scratch by converting PDFs directly.

                                    

                                                                    
                                        Improve productivity: Convert multiple PDF files simultaneously, saving significant time and boosting efficiency.

                                    

                                                            

                                                                                                No more fussing around with complicated workarounds or spending hours on tedious manual conversions. Our Turn PDF into PowerPoint feature makes it effortless to transform your PDF files into visually stunning and editable presentations. Get started now and impress your audience with engaging PowerPoint slides!

                                                            

            

        

    
            
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
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        Instructions and Help about PDF to Ppt Converter
    


            Every file format we know in today’s modern world has specific characteristics for solving various tasks. Some are more optimized for editing and agile, while others allow sharing and protecting the data they contain. The real struggle comes when you must turn one format to another, in your case Turn PDF into powerpoint, without damaging the file’s quality.

                The task is to Turn PDF into powerpoint is easier if you use the right solution. pdfFiller is the option you’re looking for. It’s easy for inexperienced people and power users and allows anyone to convert files into any desired format easily.

                Five simple steps to Turn PDF into powerpoint online in a snap

                
                        
                                    01

                    
                        Set up your pdfFiller account or sign in to an existing one.
                    

                            

                        
                                    02

                    
                        Click Add New to upload a new file and select the import or upload option.
                    

                            

                        
                                    03

                    
                        If your document needs editing, select Start editing to open it in the editor.
                    

                            

                        
                                    04

                    
                        Click the Go to My Docs button if you want to get past editing, and simply save the document in the My Docs tab.
                    

                            

                        
                                    05

                    
                        Choose the Try a template option to convert your document into a template designed for repeated use.
                    

                            

                        
                                    06

                    
                        Click Work on the doc → then click on the uploaded document → and choose Save as on the right sidebar to Turn PDF into powerpoint.
                    

                            

                        
                                    07

                    
                        Choose the preferred output format and indicate you want to save/download the file.
                    

                            

                    

                Since pdfFiller is a cloud-based solution, you can access your added document whenever you need and resume editing it. In addition, pdfFiller lets you work and organize your files and enables you to edit, annotate, protect and author and eSign documents from the convenience of your laptop or mobile phone.

                Converting documents from one format to another and vice versa is is straightforward with solutions like pdfFiller. Sign up for a free trial now!
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                            Wipe Out Certification in Jpg with ease
                        

                                            
                            Wipe Out Certification in Spreadsheet with ease
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        How to Use the Turn PDF into PowerPoint Feature
    


            Thank you for choosing pdfFiller! We are here to guide you through the process of using our Turn PDF into PowerPoint feature. Follow these simple steps to convert your PDF documents into PowerPoint presentations:

                
                        
                                    01

                    
                        Login to your pdfFiller account. If you don't have an account yet, you can easily create one for free.
                    

                            

                        
                                    02

                    
                        Once you are logged in, click on the 'MyBox' tab at the top of the page.
                    

                            

                        
                                    03

                    
                        In the 'MyBox' section, locate the PDF document that you want to convert into a PowerPoint presentation.
                    

                            

                        
                                    04

                    
                        Click on the PDF document to open it.
                    

                            

                        
                                    05

                    
                        On the right-hand side of the screen, you will see a toolbar. Click on the 'More' button, which is represented by three dots.
                    

                            

                        
                                    06

                    
                        From the dropdown menu, select the 'Convert to PowerPoint' option.
                    

                            

                        
                                    07

                    
                        A new window will appear, allowing you to customize the conversion settings. You can choose the layout, design, and other options according to your preference.
                    

                            

                        
                                    08

                    
                        Once you have customized the settings, click on the 'Convert' button.
                    

                            

                        
                                    09

                    
                        pdfFiller will start the conversion process. Depending on the size of your PDF document, this may take a few moments.
                    

                            

                        
                                    10

                    
                        After the conversion is complete, you will be able to download the PowerPoint presentation to your computer or save it directly to your pdfFiller account.
                    

                            

                        
                                    11

                    
                        Congratulations! You have successfully turned your PDF document into a PowerPoint presentation using pdfFiller's Turn PDF into PowerPoint feature.
                    

                            

                    

                We hope this guide has been helpful to you. If you have any further questions or need assistance, please don't hesitate to reach out to our support team. Happy converting!

            

    
                    
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:

        
            
                
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,5

                        

                        648 Reviews

                    

                
            

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,6

                        

                        661 Reviews

                    

                

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,4

                        

                        95k Reviews

                    

                

            
                    
                        
                    

                    
                        
                            
                                    
                                
                            

                            4,6

                        

                        9k Reviews

                    

                

        

                    
                                    
                        
                            
                                
                                    Jerilyn Fawcett - Jeri's Accounting & Tax S

                                    

                                

                                
                                    2015-05-14

                                

                            

                            
                                
                                    It has been a very interesting experience, my first time doing my return with your company. I won't need to use your service any more, so please just bill me for this one time only. I'm 89 years old and closing down my accounting business @ 5/31/15.
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                                    William K.

                                    

                                

                                
                                    2019-01-16

                                

                            

                            
                                
                                    PDFfiller has is a great application for my personal and business life
Used to fill out tax and health forms.
Used it fill forms related to my real estate business as the forms are repetitive and can be revised easily

I like that I can email documents or email them from the application
I like that I can store all of my documents in one place and retrieve them easily
I like that I can redo forms that need to be submitted annually without having to refill out the entire document.  I just update what is new.  
I can't think of any downside to the product

                                    

                                

                            

                            
                                
                                    
                                

                                
                                    
                                                                                    

                                                                                    

                                                                                    

                                                                                    

                                                                                    

                                                                            

                                    5

                                

                            

                        

                    

                            

            

                
    
        
            
                
                    
                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC

                    

                

            

            
                
                    
                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play

                    

                

            

            
                
                    
                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


        
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
                

            

            
                
                    

                    

                    

                    

                    

                    

                    

                    

                

            

        

    


                
        
            
                Did you know?
            

            
                                    
                        Inserting PDF content is not possible when editing a presentation in PowerPoint for the web. To show content from a PDF on a slide, take a picture of the part of a PDF that you want, and paste it on your slide. Insert the entire PDF into the presentation as an object that you can open and view during your presentation.


                    

                            

        

    
    
    
        
            List of extra features
        

        
                            
                    Turn PDF into CDF
                

                            
                    Turn PDF into Clickable Link
                

                            
                    Turn PDF into CSV
                

                            
                    Turn PDF into Digital Book
                

                            
                    Turn PDF into Digital Worksheet
                

                            
                    Turn PDF into DOC
                

                            
                    Turn PDF into Document
                

                            
                    Turn PDF into EBook
                

                    

    


        
        
            
                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do you change a PDF to PowerPoint on a Mac?
                        

                                                    Launch Microsoft PowerPoint, create a new PowerPoint document on Mac.
Go to Insert>Image>From File, then add the image or PDF you want to convert to PowerPoint. ... 
Once all PDF pages are imported to Microsoft PowerPoint, go to File>Save.

                                            

                                    
                        
                            
How do you turn a PDF into a PowerPoint on a Mac?
                        

                                                    Suggested clip
How to Convert PDF to PowerPoint on Mac (compatible with macOS ... YouTubeStart of suggested client of suggested clip
How to Convert PDF to PowerPoint on Mac (compatible with macOS ...

                                            

                                    
                        
                            
How do I convert a PDF to PowerPoint on Android?
                        

                                                    Click the download button below to get the app on your Android. ... 
Open the app, and you can directly tap PDF to PPT.
Press the Choose file button, choose which files you want to convert to PPT format and then hit Done.

                                            

                                    
                        
                            
How do I convert PDF to Word on Mac for free?
                        

                                                    Login to your Google account on the Google Docs website.
Upload the PDF document that you want to convert to Word.
Go to the “File” tab and choose “Download as” > “Microsoft Word(.docx)” to export this PDF file to a Word file on your MacBook.
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                Sign, send for signature, and track documents in real-time with signNow.
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